Gll-6. GEODEZIJA IR KARTOGRAFIJA GIS SISTEMOSE 2 LABORATORINIS DARBAS

ERDVINIY DUOMENUY GEOGRAFINIS ORIENTAVIMAS

Atlikimo terminas:  Darbui atlikti reikia mazdaug savaités
Praktinio darbo vertinimas:  Sis praktinis darbas vertinamas iki 32 baly, jo verté sudaro 7 proc. viso kurso
bendro pazymio.

APRASYMAS IR UZDAVINIAI

Sis praktinis darbas skirtas tam, kad susipazintuméte, kaip ArcGIS programoje orientuojami rastriniai
duomenys, ir iSmoktuméte naudotis pagrindinémis ArcGIS programy paketo komponenty ArcMap ir
ArcCatalog funkcijomis. Atlikdami apraSytus veiksmus, stenkités galvoti, kg darote, o ne vien mechaniskai
vykdyti nurodymus.

Siame praktiniame darbe jiis orientuosite tris neregistruotus atvaizdus — skenuotg topografinj zemélapj,
aeronuotrauka ir i§ interneto paimta istorinj Zemélapj — bei priskirsite jiems koordinaciy sistemos informacija.
ISmoksite du pagrindinius geografinio atvaizdy orientavimo buidus — koordinaciy priskyrimo (coordinate
input) ir atvaizdo priri§imo prie zemélapio (image-to-map georeferencing) metodus. Dirbsite su Baltijos
regiono ir Vilniaus miesto dalies duomenimis.

Baigg §j darba, turétuméte suprasti §iuos terminus ir sgvokas:

Atvaizdy geografinis orientavimas (georeferencing) arba istaisymas (rectification)
Atvaizdy koordinavimas (registration)

Perdéstymas (resampling)

Atvaizdo orientavimas pagal zemélapj (image-to-map georeferencing)
Atvaizdo orientavimas pagal atvaizda (image-to-image georeferencing)
Orientavimas jvedant koordinates (coordinate input georeferencing)
Koordinaciy sistema (elipsoido orientavimo parametrai ir projekcija)
LKS-94 koordinaciy sistema

Perspektyvinés ir plok§tuminés projekcijos

Rastrinés ir vektorinés ploksStuminés koordinaciy sistemos

Kontroliniai taskai (KT) (Ground control points (GCPs))

Vidutiné kvadratiné paklaida

KT paklaida/liekana (GCP residuals)

Koordinaciy transformacijos

Erdvinio atvaizdo skiriamoji geba (gardelés dydis)

Atvaizdo formatai (.sid, GeoTIFF, JPG2000)

ATSISKAITYMO REIKALAVIMAI
Sia dalijamaja medZiaga su jraSytais atsakymais j visus klausimus ir Zemélapius reikia pateikti per
BlackBoard nuotolinio mokymo sistema. Baigtus zemélapius jrasykite j grafinj faila (jpg) ir jterpkite Sio
dokumento pabaigoje (MS Word programoje: Insert > Picture > From file... (jterpti > paveiksla > i$ failo),
suraskite savo failg ir spustelékite Insert (jterpti)). ISsaugokite dokumenta.

PASIRUOSIMAS

Duomenys

Pries pradédami §j praktinj darba, C:\Data aplankale sukurkite naujg aplanka G1106_2 ir j jj nukopijuokite $io
pratimo duomenis.
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Literatiira ir elektroniniai vadovai

= 2 dalis. ,,Erdviniy duomeny pobudis ir Saltiniai*“: paskaitos tekstas ir PPT skaidrés.

= Rastriniy duomeny orientavimas ArcGIS programoje (Geo-referencing Rasters in ArcGIS), ,,ESRI
Virtual Campus Course* nuotoliniy mokymy kursas

= Elektroninis ArcGIS darbalaukio Zinynas 9.2 (ArcGIS Desktop Help 9.2):
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=2592&pid=2583&topicname=Geo-
referencing_a_raster_dataset

* Tie mokymo dalyviai, kurie yra jsidiege ArcGIS programing jrangg gali naudotis ir visais ArcGIS
vartotojo vadovais, kurie programos jdiegimo metu yra jkeliami j C:\Program
Files\ArcGIS\Documentation kataloga. Siuose vadovuose pateikiama puiki mokomoji medziaga apie
kiekvieng ArcGIS komponentg ir jo plétinius, o taip pat jais galima naudotis kaip Zinynais. Jie padés jums
atlikti kurso uzduotis ir suteiks galimybe savarankiskai tyrinéti kitus ArcGIS aspektus.
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PRATIMAI

IS antrosios kurso dalies paskaitos medziagos suzinojote, kad erdvinius duomenis galima jvesti keliais
budais. Yra keturi pagrindiniai erdviniy duomeny $altiniai:

e turimi bendrieji ir teminiai zemélapiai (skaitmeniniai arba popieriniai);

e geodeziniy matavimy ir padéties nustatymo duomenys;

e nuotoliniy tyrimy duomenys;

e gyventojy suraSymo, atrinkty im¢iy, ataskaity ir leidiniy duomenys.

Siame laboratoriniame darbe i§moksite GIS sistemoje dirbti su naujais rastriniais atvaizdais. Sie atvaizdai
gali biti nuskenuoti bendrieji arba teminiai zemélapiai, nuotoliniy tyrimy atvaizdai arba aeronuotraukos.
Kontrolinius taSkus naujy duomeny orientavimui galima gauti i§ GPS arba nuotoliniy tyrimy duomeny ir
(ar) turimy popieriniy arba skaitmeniniy orientavimo duomeny. Geografiskai orientuotus naujuosius
erdvinius duomenis galima naudoti topografiniams ir teminiams zemélapiams kurti bei atnaujinti.

Atvaizdy geografinio orientavimo (georeferencing) arba istaisymo (rectification) procesa sudaro keli
etapai.

e Popieriniy atvaizdy skenavimas — jei néra skaitmeniniy atvaizdy. Skenavimas yra greitas biidas
erdviniams duomenims konvertuoti j skaitmeninj formatg. Skeneris pradinj analoginj dokumenta
pavercia skaitmeniniu rastriniu. Prie§ skenuojant labai svarbu pasirinkti tinkama skiriamaja geba.
Nors didele skiriamaja geba nuskenuojamos smulkesnés detalés, taciau nuskenuojami ir
nepageidautini elementai, pavyzdziui, popieriaus pluostas arba nuotrauky grideliai. Be to,
gaunamas didesnis atvaizdo failas. Nustacius mazesn¢ skiriamaja geba, praleidZziamos smulkios
atvaizdo detalés.

o Skaitmeninio atvaizdo padéties nustatymas geografingje ir (arba) Zemélapio koordinaéiy sistemoje.
Gan daznai galite gauti nuskenuoty, bet geografiskai neorientuoty atvaizdy — ypa¢ aeronuotrauky.
Tai yra nenurodyta atvaizdy projekcija arba elipsoido orientavimo parametrai. Kad Siuos atvaizdus
bty galima naudoti GIS kartu su geografiskai orientuotais, reikia orientuoti atvaizdg geografinéje
arba projekcingje koordinaciy sistemoje.

e Geometrinis koregavimas. Nuotolinio tyrimo atvaizdas paverciamas plok§tuminiu atvaizdu
zemélapio koordinaciy sistemoje.

e Ataizdo perdéstymas (resampling). Duomenys ekstrapoliuojami j naujg rastrg. Perdéstymas yra
atvaizdo istaisymo etapas, kuriuo i§ pradinio rastro apskaiiuojamos naujosios istaisyto rastro
gardeliy vertés. KeicCiant atvaizdo mastelj, sukant atvaizda ar atliekant sudétingesnes
transformacijas perdéstymo i§vengti nejmanoma, bet galima pasirinkti perdéstymo tipa.

Geografinio orientavimo procesas yra labai dazna praktiné GIS uZduotis.

Kartais ji vadinama geografiniu koordinavimu (registration). Rastro geografinis koordinavimas — tai
dviejy ar daugiau duomeny rinkiniy (rastriniy ir (ar) vektoriniy) geometrinis lygiavimas, po kurio galima
atlikti tos pagios Zemés srities skaitmenine arba vizualia superpozicija. Zemélapio koordinaciy sistema $iam
procesui nebiitina.

Trumpai tariant, geografinio orientavimo procesui paprastai reikia:
e skenuoto atvaizdo, kuris véliau iStaisomas (pvz., aeronuotraukos, palydovinio atvaizdo, skenuoto
topografinio ar teminio Zemélapio);
e Kkontroliniy tasky (KT) Saltinio (pvz., GPS arba geodeziniy matavimy, turimy zemélapiy arba
geografiSkai orientuoty atvaizdy);
e @IS arba nuotoliniy tyrimy programinés jrangos su tam tikras atvaizdy transformacijas (pvz.,
afinines, projekcines, istempimo ir kt.) palaikan¢iomis priemonémis.
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Geografinis orientavimas
* Kontroliniy tasky pasirinkimas
* Atvaizdo transformavimas

— gardeliy perdéstymas
Sukti

Keisti mastelj -
Transformuoti

Pav. Geografinio orientavimo procesas

Techniniu poziiiriu, pagal programines priemones ir naudojamus kontrolinius taskus galima isskirti bent tris
geografinio orientavimo tipus:
e neapdorotas atvaizdas orientuojamas pagal geografiskai orientuotga Zemélapj (atvaizdo
orientavimas pagal Zemélapj (image-to-map geo-referencing));
e neapdorotas atvaizdas orientuojamas pagal iStaisyta atvaizda (atvaizdo orientavimas pagal
atvaizda (image-to-image geo-referencing));
e oOrientuojama pagal kontroliniy tasky koordinates (orientavimas jvedant koordinates (coordinate
input geo-referencing)).

Pav. Geografinio orientavimo procesas

Geografinio orientavimo procesa sudaro keliy atvaizde aiskiai atpazjstamy kontroliniy tasky koordinaciy
(t. y. stulpeliy ir eilu¢iy) nustatymas pradiniame atvaizde (A: Al — A4) ir jy sutapdinimas su tikromis $iy
tasky geografinémis koordinatémis (pvz., ilguma ir platuma). Tikrosios geografinés koordinatés (B: B1 —
B4) paprastai iSmatuojamos geodeziniais matavimais arba nustatomos i§ popierinio arba skaitmeninio
zemélapio. Sis procesas vadinamas atvaizdo orientavimu pagal Zemélapj. Nustadius kelias gerai
i8déstytas kontroliniy tasky poras, kompiuteris apdoroja jy koordinaiy informacija ir nustato atitinkamas
pradiniy (eiluéiy ir stulpeliy) atvaizdo koordinaciy transformavimo lygtis, kuriomis Sios koordinatés
atvaizduojamos | geografines. Geografiskai orientuoti vieng ar kelis atvaizdus galima ne tik priskiriant
geografines koordinates, bet atvaizda galima orientuoti ir pagal kita atvaizda. Sis procesas vadinamas
atvaizdo orientavimu pagal atvaizda ir daznai atlickamas pries jvairias atvaizdo transformacijas.
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Siame darbe jums reikia orientuoti nuskenuota topografinj Zemélapj, aeronuotrauka ir istorinj Lietuvos
zemélapi.

1) Paleiskite ArcMap per Windows paleisties meniu (Start > Programs > ArcGIS > ArcMap). Kai
ArcMap pasileis, pasirodys klausimas, ka daryti toliau; pazymékite A new empty map (sukurti nauja
tusciag zemélapj) ir spustelékite OK (gerai).

1 dalis. Geografinis orientavimas priskiriant koordinates

Pirmiausia jums reikia pagal kontroliniy tasky koordinates orientuoti Vilniaus topografinj Zemélapj
(orientavimas jvedant koordinates).

2) Pakeiskite duomeny srities pavadinimg (numatytasis pavadinimas yra ‘Layers') i 'Topografinis
Zemélapis'": spustelékite Layers duomeny srities pavadinimg ir surinkite naujg pavadinimg. ISsaugokite
(&) ArcGIS Zemélapio dokumenta savo darbiniame aplanke pavadinimu "Geo-orientavimas.mxd".

1 klausimas. Kokia projekcija rodoma tuscioje jiisy Zemélapio duomeny srityje? IS kur tai Zinote?

3) Desiniuoju mygtuku spustelékite Topografinio Zzemélapio duomeny sritj ir atverkite duomeny srities
savybiy (Data Frame Properties) dialoga. Koordinaciy sistemos (Coordinate System) skyrelyje
nurodykite Lietuvos koordinaciy sistema ir projekcija (LKS-94), kuri ir bus Topografinio Zemélapio
duomeny srities koordinaciy sistema. Daugiau apie Sig koordinaciy sistema ir Zemélapio projekcijas
suzinosite kitose kurso dalyse.

Visas Lietuvos koordinaciy sistemos LKS 94 aprasas:

» Projekcija: skersiné Merkatoriaus
= |lgumos poslinkis: 500000,00
= Platumos poslinkis: 0,0
= ASinis dienovidinis: 24,00
= ASinio dienovidinio mastelio koeficientas: p = 0,9998
= Pradiné platuma: 0,0 (pusiaujas)
= |lgio vienetas: metras
= Geografiné koordinaciy sistema: GCS_LKS 1994
= Kampy matavimo vienetas: laipsnis (0,017453292519943299)
»  Pradinis dienovidinis: Grinvico (0,0)
= Elipsoido orientavimo parametrai: D_Lithuania_1994
= Sferoidas: GRS 1980
* Didysis pusasis: 6378137,00
»  Mazasis pusasis: 6356752,314140356100
= Atvirkséias paplokstumas: 298,25722210100002000

4) Koordinaciy sistemos (Coordinate System) skyrelyje spustelékite Import (importuoti), atverkite savo
darbinj aplanka ir pazymékite Roads.shp. Sis keliy failas jau orientuotas LKS-94 sistemoje. Sio failo
koordinaciy sistemos informacija bus tiesiog perduota jasy Topografinio zemélapio duomeny sriéiai.
Atlikdami kitus pratimus, iSmoksite apibrézti koordinaciy sistemag nuo pat pradzios.
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5) Koordinaéiy sistemos skyrelio dialogo lange pamatysite pazjstamus LKS-94 parametrus. ISanalizuokite
juos. Spustelekite OK ir uzdarykite §j dialoga.

Dar kartg i$saugokite "Geo-orientavimas.mxd" dokuments.

6) Prie zemélapio pridékite rastriniy duomeny sluoksnj 76_32naujas.tif: spustelékite mygtuka Add Data

(pridéti duomenis, ¥) ir atverkite savo darbinj kataloga; spustelékite 76_32naujas.tif ir Add (pridéti).
Jei norite pagreitinti duomeny apdorojimo operacijas, galite sukurti piramides. Jei spustelésite mygtuka
OK, pasirodys atvaizdas, bet turinyje tai nebus orientuotas atvaizdas.

2 klausimas. Kokia yra 76_32naujas.tif rastrinio atvaizdo projekcija? Is kur tai Zinote? 1

7) Dabar duomeny rodinio (Data View) lange matysite skenuotg 1:10 000 mastelio topografinj Vilniaus
zemélapj. Sis atvaizdas turi 3 RGB kanalus arba juostas (Raudona: 1 juosta; Zalia: 2 juosta; Mélyna: 3
juosta).

= £F Topografinis Zemélapis
= 7E_32naujas.of
R.GB
M Fred: Band 1
M Green: Band_2
M Eue: Band_3

3 klausimas. Kaip vadinama $iy juosty kombinacija ir ekrane rodomos spalvos? (Patarimas: skaitykite 1
http://www.fas.org/irp/imint/docs/rst/Sect1/Sectl_10.html)

. sy

e 3

;“"I\\y' 5
—

8) Stumiant zymeklj I&=¥ zemélapiu, zymeklio padéties koordinatés rodomos apatinéje informacijos

[B.181 14.93 Meters

juostoje (pvz., ). Nesunkiai atspésite, kad tai néra nei geografinés, nei projekcinés
koordinatés. Tai yra, $ios koordinatés nenurodo Zymeklio rodomy Zemélapio objekty vietos ant Zemés
pavirsiaus. Sj topografinio zemélapio atvaizda reikia orientuoti geografinéje koordinaciy sistemoje.

9) ArcMap lange atverkite geografinio orientavimo (Geo-referencing) mygtuky juosta: pasirinkite View >
Toolbars > Geo-referencing (rodymas > mygtuky juostos > geografinis orientavimas). Pastumkite arba
pritvirtinkite §ig mygtuky juostg ten, kur jums patogiau.

10) Spustelékite geografinio orientavimo (Geo-referencing) juostos mygtuka View Link Table (rodyti rysiy

lentele, — ). Perkelkite Sig lentele j ArcMap lango krasta.
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11) Padidinkite ® desinjjj virSutinj Zemélapio kampg. Sio kampo LKS-94 koordinatés X (rytinis

6065

e

prieaugis) = 585 km arba 585000 metry, Y (Siaurinis prieaugis) = 6065000 metry (:ﬁ:ﬁ:ﬁ: = ).

Pabandykite labai stipriai padidinti §j kampa ( ).

12) Spustelékite geografinio orientavimo juostos jrankj Add Control Points (pridéti kontrolinius taskus,

< ). Pele spustelékite neorientuoto atvaizdo rémelio linijy sankirtos taska, ir bus pridétas pirmasis

kontrolinio taSko saitas . Si veiksmg reikia atlikti kuo tiksliau. Deginiuoju mygtuku
spustelékite atvaizda, tada spustelékite Input X and Y (jvesti X ir Y).

13) Koordinaéiy jvedimo iEnter Coordinates) dialogo lange jveskite tasko koordinates i§ zemélapio.
Enter Coordinates

x|

¥: [585000

Y« |B0BS000

ak I Cancel |

Spusteléekite OK. 3 LKS-94 atstumai matuojami metrais, todé¢l jus ir
ivedéte koordinates metrais (LIN2ar Unit: Meter )

14) Turinyje deSiniuoju mygtuku spustelékite paskirties sluoksnj — orientuotg duomeny rinkinj — ir
spustelékite Zoom to Layer (didinti iki sluoksnio).

15) Kartodami Siuos keturis Zingsnius, jveskite likusiy 3 Zemélapio kampy koordinates. Patartina retkarciais

issaugoti savo .mxd projekta. leSkant kontroliniy tasky ir juos pridedant, jrankius @, @ ir < galima
naudoti beveik bet kuria tvarka.

Kad orientuotumeéte topografinj Zemélapj zinomoje koordinaciy sistemoje ir projekcijoje, paprastai pakanka
nurodyti 4 Zemélapio kampy kontroliniy tasky koordinates. Atminkite, kad prie§ pridedant prie Zemélapio
neorientuotus atvaizdus, reikia nustatyti ArcMap duomeny srities koordinadiy sistema. Jei jusy tasky
koordinatés yra ilguma ir platuma, pasirinkite geografing koordinaciy sistemg su atitinkamais orientavimo
parametrais (pvz., WGS84). Jei taSky koordinatés nurodytos metrinéje projekcingje sistemoje, kaip Siuo
atveju, pasirinkite, pavyzdziui, LKS-94 su tam tikrais parametrais. Siuo atveju Siuos parametrus jis
nurodéte jkéle Roads.prj projekcijos apibrézties failg.

16) Kai jvesite bent 4 kontroliniy zemélapio tasky poras, ArcMap apskaiciuos kiekvieno kontrolinio tasko
vidutine kvadrating paklaida (Root Mean Square error — RMS) arba liekang ir jy suma. Sias paklaidas
matysite atvére rySiy lentele (mygtukas View Link Table). Jei suskaifiuota paklaida mazesné uz
nustatyta riba, geografinis orientavimas yra tinkamas. Be to, rySiy lentelé¢je (Link Table) arba
transformacijos meniu (Geo-referencing > Transformation) galima pamatyti ir pakeisti transformacijos

tipa.

Vidutiné kvadratiné paklaida atspindi skirtuma tarp pradiniy kontroliniy tasky ir transformuojant
apskai¢iuoty naujy kontroliniy taSky viety. Vidutiné kvadratiné paklaida nurodoma Zzemélapio matavimo
vienetais. Jei geografiniai duomenys turi buti labai tikslts, zemélapyje vidutiné kvadratine paklaida neturi
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virSyti 0,01 cm. Miisy atveju 1 cm Zemélapyje atitinka 100 metry ant Zemés; taigi 0,01 cm atitinka 1 metra.
Taigi, musy vidutiné kvadratiné paklaida turi btiti mazesné uz 1.

Didelé vidutiné kvadratiné paklaida daugiausia gaunama todél, kad ekrane rodomame Zemélapyje netiksliai
jvedami kontroliniai taskai arba skenuojamas suglamzytas Zemélapis. Kad rezultatai bty tikslesni,
skaitmenindami kontrolinj taskg patikrinkite, kad manipuliatoriaus linijy sankirtos taSkas sutapty su
kontroliniu taSku.

17) Jei gautos vidutinés kvadratinés paklaidos jtsy netenkina (ne mazesnés uz 1), reikia pasalinti rySius
(kontrolinius taskus), kuriy vidutiné kvadratiné paklaida bloga, ir i§ naujo tiksliau pridéti Siuos
kontrolinius taSkus.

18) Issaugokite savo kontrolinius taSkus, tik prie§ iSsaugodami atzymékite visus pazymétus taskus —
prieSingu atveju bus iSsaugoti tik pazyméti taskai: spustelékite rySiy lentelés mygtuka Control Points
Saves (issaugoti kontrolinius taskus), ir jvesti kontroliniai taskai bus jraSyti j kontroliniy tasky faila.. I$
Sio failo vélaiu galima jkelti (Load) kontrolinius taskus j rySiy lentele atliekant Kitus zemélapio
orientavimus.

4 klausimas. Pateikite jvertinimui rysiy lentelés ekrano nuotraukq su jvestais 4 kontroliniy tasky rysiais. 5
5 klausimas. Pateikite geografiskai orientuoto topografinio Zemélapio ArcMap ekrano nuotraukg. 1

19) Atlike¢ Siuos veiksmus, spustelékite geografinio orientavimo (Georeferencing) isskleidziamajj meniu ir
spustelékite jo komandg Update Geo-referencing (atnaujinti orientavimg); bus i$saugota rastrinio
duomeny rinkinio transformacijos informacija. Ji jraSoma j naujg faila, kurio pavadinimas toks pats,
kaip duomeny rinkinio, o plétinys .aux.xml. Taip pat sukuriamas .tif failo orientavimo failas (world file)
su .tfwx plétiniu. Galite uzverti rysiy lentele.

Dabar jisy geografiSskai orientuotg rastrinj topografinj Zemélapj sudaro trys 76_32naujas failai su .tif,
tfwx ir .aux.xml plétiniais. Sie failai turi biiti tame pa¢iame aplanke; jei norite nukopijuoti §j zemélapj kam
nors kitam, kopijuokite visus Siuos failus, kad kitas zmogus ArcMap programoje galéty dirbti su
geografiskai orientuotu atvaizdu.

Jei norétuméte visam laikui transformuoti pradinj atvaizdg ir jrasyti j nauja faila (pvz., (Geo)Tiff formato),
turétuméte naudoti geografinio orientavimo meniu istaisymo komanda (Rectify). Ja naudosime kitose Sio
darbo uzduotyse.

2 dalis. Atvaizdo geografinis orientavimas pagal Zemélapj

Sioje darbo dalyje jums reikia geografiskai orientuoti aeronuotrauka.

20) ArcMap programoje jterpkite nauja duomeny sritj: spustelékite pagrindinio ArcMap meniu komanda
Insert > Data Frame (jterpti > duomeny sritj). | turinj bus jrasyta nauja duomeny sritis. Pavadinkite $ig
sritj Aeronuotrauka. Aktyvios srities pavadinimas turinio lenteléje pastorintas. Jei norite suaktyvinti
sritj, spustelékite jg deSiniuoju pelés mygtuku ir pazymékite parinktj Active (aktyvi).

21) Nurodykite, kad Aeronuotraukos duomeny srities koordinaciy sistema bus Lietuvos koordinaciy
sistema (LKS-94), panasiai, kaip tai anks¢iau daréte Topografinio Zemélapio duomeny sriciai.
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6 klausimas. Kokie LKS-94 koordinaciy sistemos elipsoido orientavimo parametrai(datum)? 1

22) ArcMap programa pridékite upiy, upiy poligony ir keliy sluoksnius (Rivers, Hidro_p ir Roads) i
savo GII06_2 aplanko. Jei norite pagerinti kontrasta, galite pakeisti vektoriniy sluoksniy simbolius.

23) Prie zemélapio pridékite 7632.sid rastrinj sluoksnj. Spustelékite OK, ir bus sukurtos piramidés.

24) Jei padidinsite atvaizdg iki visos aprépties (Full Extent, @ ), pastebésite, kad jasy orientuoti
vektoriniai ir neorientuoti rastriniai duomenys yra skirtingose koordinaciy sistemose ir nesutampa.
Padidinkite atvaizdg iki 7632 sluoksnio: desiniuoju mygtuku spustelékite sluoksnj, tada spustelékite
Zoom to Layer (didinti iki sluoksnio); iSanalizuokite atvaizdo koordinates (stumkite Zymeklj atvaizdu,

ir koordinates matysite apatin¢je informacijos juostoje — pavyzdziui, 4273.085 -7921.126 Meters).
7632 sluoksnis yra plokStumingje rastriniy koordinadiy sistemoje; §ios koordinatés nesutampa su
ploks$tuminémis vektorinémis koordinatémis.

LY
(0,0) X 7 ¥

y

& (0,0) X
Pav. Rastrinés ir vektorinés plok§tuminés koordinaciy sistemos

25) Dabar padidinkite atvaizda ekrane iki vieno i§ vektoriniy sluoksniy ir panagrinékite jo koordinates. Sio
sluoksnio koordinaciy sistema yra LKS-94.

Dabar turite kelis sluoksnius (pvz., keliy elementy rinkinys) Zemélapio koordinaciy sistemoje ir atvaizda,
kurj reikia orientuoti. 7632 atvaizda jums reikés orientuoti pagal pagrindiniy Vilniaus keliy ir gatviy
sankirtas. Geriausiai tam tikty pastaty kampai, ta¢iau mes $iy duomeny neturime.

26) Turinio lenteléje deSiniuoju mygtuku spustelékite keliy (Roads) paskirties sluoksnj (orientuota
duomeny rinkinj) ir padidinkite atvaizda ekrane iki S$io sluoksnio (Zoom to Layer). Geografinio
orientavimo mygtuky juostoje 7632 sluoksnis turi buti nurodytas kaip orientuojamas sluoksnis

(|?632.sid =] ).

27) Spustelékite geografinio orientavimo meniu komanda Fit to Display (talpinti | matoma atvaizda).
Atvaizdas bus parodytas toje pacioje srityje, kaip ir vektoriniai paskirties sluoksniai. Kad pamatytuméte

Bl

visus duomeny rinkinius, galite stumti (Shift, 1) rastriniy duomeny rinkinj ir keisti jo mastelj (Scale,

Iﬁ) . Kad pakeistuméte rastrinio sluoksnio mastelj, laikykite paspausta pelés mygtuka ir vilkite ji
rastriniu  sluoksniu, kol gausite reikiamg sluoksnio dydj. Kai jjunge mastelio keitimo jrankj
paspaudziate pelés mygtuka, Zemélapyje pasirodo rastrinio sluoksnio riby sta¢iakampis. Atsizvelgiant j
zymeklio tempimo Kryptj jis didéja arba mazéja.
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Zemélapiy ir aeronuotrauky geometriniai principai skiriasi. Aeronuotrauka iskart sukuriama kaip
perspektyviné projekcija per optinj objektyva; zemélapj galima sukurti bet kokioje projekcijoje. Dauguma
topografiniy Zemélapiy sudaromi plokStuminio projektavimo principais. Kad buty galima orientuoti
atvaizda kitoje koordina¢iy sistemoje sudarytame zemélapyje, reikia daugiau negu 4 kontroliniy tasky. Sis
geografinis orientavimas panasus ] atvaizdy iskraipyma.

Mastelio sumaiinimas

1111

Reljefas L~

Pav. Aeronuotraukos projekcija centriné arba perspektyviné, 0 Zemélapio — ortografiné arba plokStuminé

28) Spustelékite kontroliniy tasky jrankj (Control Points, ' ) ir jveskite kontrolinius taskus. Kad
pridétuméte rysj, pele spustelékite zinoma rastriniy duomeny vieta, pavyzdziui, Gelezinio Vilko gatvés
tilto centra, o po to spustelékite tg pacia vieta zemélapio koordinatése pateikty (orientuoty) duomeny
rinkinyje. Pridedant rySius kartais pravercia didinimo (Magnification) langas. Ieskant kontrolinio tasko,
taip pat galima naudotis ekrano mastelio keitimo (Zoom In, Zoom Out) arba perstumimo (Pan)

jrankiais.

Pav Kad pridétuméte pirmaji rysj, pele spusteleklte Gelezmlo vilko tilto centra, o po to spustelékite ta pacia vieta Zemélapio
koordinatése pateikty (orientuoty) duomeny rinkinyje.

Atsizvelgiant j pasirinktos formulés laipsnj arba nezinomy parametry skaiCiy, reikia pasirinkti nuo
deSimties iki dvideSimties taSky, aiSkiai matomy ir atvaizde, ir Zemélapyje. Kontroliniai taskai turéty bati
iSdéstyti atsitiktinai, bet mazdaug vienodais tarpais; jy turi biiti ir kampuose. Nuo kontroliniy tasky
i§sidéstymo ir skaiciaus priklauso geografinio orientavimo ir geometrijos koregavimo tikslumas.
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Transformacijos formulés pasirinkimas priklauso nuo koreguojamo atvaizdo tipo. Jei

atvaizdas

transformuojamas toje pacioje koordinaciy sistemoje, paprastai gerai tinka afininé transformacija. Jei
transformuojamos aeronuotraukos arba palydoviniai atvaizdai, pakanka ne didesnio negu tre¢io laipsnio
polinominés transformacijos. Polinomy laipsnis nustatomas pagal geometrinius iskraipymus. Siuo atveju
kontroliniy tasky skaiCius turi biiti didesnis negu nezinomy polinomo parametry skai¢ius (zr. lentelg), nes
paklaidos koreguojamos maziausiy kvadraty metodu.

9.5.1 lentelé. Transformavimo formulés

(X, y): zemélapio koordinaciy sistema

(u, v): atvaizdo koordinaéiy sistema

Nezinomy parametry

transformacija

Pavadinimas Transformavimo formulé e
skaiéius
1) Helmerto transformacija X=au+bv+c
(mastelio keitimas, poslinkis 4
ir posiikis) y=-butav+d
2) Afininé transformacija X =au+bv+c 6
y=du+ev+f
3) Pseudoafininé X =a,uv+a,u+av+a, 8
transformacija y = asuv +agu +a7v + ag
_ajutay+ay
4) Projekcijos T Tamutag+1 g
transformacija _aqu tasv+ag
a;u+ag+1
5) Antros eilés konforminé X=a,u+a,v+a, (uz—vzj + 2a,uv + as 6

y =—a,u+a,v+2auv —a, (-3 +a,

6) Polinominés
transformacijos

x=ZXFa;u vt
y=%%bu'" v’

Pav. Transformavimo formulés

29) Kad jvertintuméte transformacijg, spustelékite mygtuka View Link Table (rodyti rysiy lentelg, ).
Perkelkite $ig lentelg | ArcMap lango krasta. Dabar lenteléje yra vienintelis rySys. Galite jvertinti
kiekvieno rySio lickamajj nuokrypj (residual error) ir visa viduting kvadrating paklaida. Véliau jis
pridésite daugiau rysiy ir galésite pakeisti transformacijos tipa. Pirmo laipsnio transformacijai reikés
bent trijy ry$iy, antro laipsnio — $esiy, trecio laipsnio — deSimties.

30) Sukurkite dar penkis atvaizdo ir Zemélapio kontroliniy taSky rySius. Pasirinkite antro laipsnio
transformacija: Georeferencing > Transformation > 2™ Order Polynomial (geografinis orientavimas >
transformacija > 2 laipsnio polinominé). ISanalizuokite liekamuosius nuokrypius. Jei norite pagerinti
visg viduting kvadrating paklaida, galite pagerinti atskirus liekamuosius nuokrypius, i§ naujo jvesdami
taskus pele arba keisdami jy koordinates rysiy lenteléje (Link Table), o taip pat galite pasalinti labai
,nestabilius* kontrolinius taskus su dideliu liekamuoju nuokrypiu. Turi biti parinkti tokie kontroliniai
taskai, kurie nekinta laikui bégant ir tikrai yra toje pacioje vietoje ir atvaizde, ir Zemélapyje

(vektoriniuose sluoksni

uose).

31) Galima pridéti daugiau kontroliniy tasky, pasirinkti tre¢io laipsnio transformacijg ir palyginti
orientavimo rezultatus su ankstesniaisiais. Jums reikia gauti kuo geriau orientuota atvaizda LKS-94
koordinaciy sistemoje. Galite pasirinkti geriausig transformacijos tipg. Jei gauti rezultatai jums tinka,
daugiau rysiy jvesti nereikia.
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7 klausimas. Pateikite jvertinimui rysiy lentelés ekrano nuotraukq su jvestais rysiais. 5

8 klausimas. Pateikite geografiskai orientuotos aeronuotraukos ArcMap ekrano nuotraukg. 1

9 klausimas. Tarkime, norite istaisyti atvaizdg (rectification) ir pazymite kelis kontrolinius taskus ant 3
gamtiniy (pvz., upés issisakojimas) ir dirbtiniy objekty (pvz., sankryza). Trumpai aprasykite priezastis,

dél kuriy vieny pazZyméty kontroliniy tasky pradinés vidutinés kvadratinés paklaidos gali biti didesnés

arba mazesnés negu kity. Kaip atvaizdo istaisymg gali palengvinti ar pasunkinti tokios atvaizdo savybés

kaip nagrinéjamos teritorijos padétis arba naudojamos jutikliy sistemos(sensor system) skiriamoji geba

(pvz., erdviné skiriamoji geba arba gardelés dydis)?

32) Kad 7632 atvaizda transformuotuméte visam laikui ir jraSytuméte j naujg faila, spustelékite geografinio
orientavimo (Georeferencing) meniu komanda Rectify (istaisyti); nurodykite ta patj gardelés dydj, kaip
ir pradinio failo, artimiausio kaimyno (Nearest Neighbor) perdéstymo tipg ir (Geo)Tiff formata.
Orientuoto atvaizdo i$saugojimas gali Siek tiek uztrukti, o pac¢iam atvaizdui gali reikéti nemazai vietos
diske.

33) ArcCatalog programa i§ Roads SHAPE failo priskirkite naujajam atvaizdui koordinaciy sistemg (LKS-
94): desiniuoju mygtuku spustelékite atvaizdo sluoksnj, tada spustelékite savybiy meniu (Properties)
bei prie erdvinio orientavimo (Spatial Reference) esantj redagavimo (Edit) mygtuka. Dabar jusy
naujasis atvaizdas yra geografiskai orientuotas ir jam priskirta koordinaciy sistema. Jis saugomas
GeoTiff formato faile, kurio antrastéje saugoma informacija apie koordinaciy sistema.

34) Dar kartg issaugokite ArcGIS dokumentg "Geo-orientavimas.mxd".

10 klausimas. Kokia gauto geografiskai orientuoto atvaizdo erdviné skiriamoji geba (gardelés dydis)? 1

3 dalis. Istoriniy Zemélapiy geografinis orientavimas
Sioje darbo dalyje orientuosite i§ interneto parsisiysta istorinj Zemélapj.
35) Sukurkite naujg ArcMap duomeny sritj ir pavadinkite ja Baltics_1350-60.

36) Nurodysime Sios srities koordinaciy sistemg su S$iais parametrais: kiiginé lygiatarpé projekcija, 30
laipsniy aSinis dienovidinis, 50 ir 60 standartinés lygiagretés, WGS1972 elipsoidas. Duomeny srities
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savybiy (Data Frame Properties) dialogo koordinaéiy sistemos Coordinate System korteléje nurodykite
koordinaciy sistema: Predefined > Projected Coordinate Systems > Continental > Europe > Europe
Equaldistance Conic > Apply (numatytosios > projekcinés koordinaciy sistemos > Zemyninés >
Europos > Europos lygiatarpé¢ kuginé > vykdyti). Pakoreguokite S$ig projekcija: pasirinkite
Select>Geographic Coordinate System > World > WGS1972 > Add (geografiné koordinaciy sistema >
pasaulio > WGS1972 > pridéti) ir pakeiskite asinj dienovidinj (Central_Meridian) i 30 laipsniy,
standartines lygiagretes (Standard_Parallels) j 50 ir 60; spustelékite OK ir dar kartg OK.

37) Orientuokite baltics_1350-60.jpg zemélapio atvaizda
(http://www.lib.utexas.edu/maps/historical/baltics_1350-60.jpg) pagal Water.shp ir Continent.shp
sluoksnius.

38) Kontroliniais taskais galima pasirinkti upiy sankirtos ir kranto linijy taskus. Arba galima sukurti 5
laipsniy geografiniy koordinaciy tinklelj ir kontroliniais tadkais pasirinkti jo linijy sankirtos taskus. Sj
tinklelj pridéti galite panasiai kaip zemélapio tinklelj 1 laboratoriniame darbe. Patarimas: jei norite po
atvaizdu matyti zemélapio objektus, atvaizda galite orientuoti maketo rodinyje (Layout View) ir pakeisti
atvaizdo skaidrumg (transparence).

39) Pasirinkite tokj transformacijos laipsnj, kad gautuméte maziausig viduting kvadrating paklaida, ir
atvaizdas kuo geriau sutapty su zemélapiu.

40) Kad baltics_1350-60.jpg atvaizda transformuotuméte visam laikui, spustelékite geografinio
orientavimo (Georeferencing) meniu komanda Rectify (iStaisyti) ir jrasykite atvaizda j nauja jpg2000
(JP2) formato failg, pasirinkg¢ 100 proc. kokybés suspaudimo nuostatg. Kad pamatytuméte rezultata,
ArcMap programa pridékite naujojo istaisyto atvaizdo faila. | jpg2000 (JP2) formato failus galima
jrasyti koordinaciy sistemos informacija.

41) Dar kartg iSsaugokite ArcGIS dokumentg "Geo-orientavimas.mxd".
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http://www.lib.utexas.edu/maps/historical/baltics_1350-60.jpg

11 klausimas. Pateikite jvertinimui baltics_1350-60.jpg rysiy lentelés ekrano nuotraukq su jvestais 5
rysiais.

12 klausimas. Pateikite geografiskai orientuoto baltics_1350-60 Zemélapio ArcMap ekrano nuotraukg. 1

13 klausimas. Kokie yra atvaizdo orientavimo Zemélapyje pranasumai ir trickumai, palyginti su 2
orientavimu jvedant koordinates?

14 klausimas. Kiek kontroliniy tasky reikia pasirinkti, kad biity galima jvertinti nuokrypius? Kodeél? 2

15 klausimas. Kq galima padaryti, jei gauta Visa vidutiné kvadratiné paklaida didesné negu 1,0? 2

Keletas klausimy ir atsakymy:

K. Ar galiu skaitmeninti atvaizdq ir sukurti Zemélapj, o geografiskai orientuoti atvaizdg ir Zemélapj
véliau? (Jei visai neturiu jo GPS koordinaciy?)

A. Galima sukurti Zemélapj i§ neapdoroto atvaizdo, bet jiisy vektoriniai duomenys bus neorientuoti ir teks
veliau juos transformuoti | tam tikrg koordinaciy sistema ArcMap vektoriniy duomeny transformavimo
irankiu, kuris skiriasi nuo atvaizdy transformavimo jrankio. Taigi teks atlikti dviguba darba. Patartina
pirmiausia orientuoti pradinj atvaizda, o po to jj paversti vektoriais.

K. Jei turiu, pavyzdziui, medziy GPS koordinates ir noriu jvesti jas j Zemélapj, ar galiu jas jvesti
deSimtainiais laipsniais, ar reikia jas konvertuoti j x,y koordinates?

A. Galima jvesti ilgumos ir platumos (Lat/Long) arba metrines (pvz., UTM) koordinates. Bet jvedant
koordinates reikia Add XY Events (XY jvykiy) dialogo lange nurodyti koordinaciy sistema. Jvykiy jvesties
koordinaciy sistema turi biiti ta pati kaip ir jvesties duomeny koordinaciy sistema (pvz., jei duomenys yra
ilgumos ir platumos sistemoje, tai bus geografiné (Geographic) sistema, pvz., WGS84).
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Komentaras. Atminkite, kad ArcMap viename zemélapyje gali perdengti skirtingy koordinaéiy sistemy
sluoksnius. Véliau pridétus sluoksnius programa perprojektuoja j pirmuyjy j turinj pridéty sluoksniy sistema.
Taciau tai tik dinaminis projektavimas, skirtas zemélapiui parodyti ekrane. Pridéty sluoksniy koordinatés

failuose nekei¢iamos.
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